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Abstract 

Environmental variability during the development of an organism has known impacts on 

the expression of certain behavioural patterns. The fruit fly Drosophila melanogaster was 

used to investigate on how different environmental conditions interact with the allelic 

variants of rover (forR) and sitter (fors) at the foraging locus to affect food-related 

behaviour of larvae. In this study, larval density and nutrient availability could be 

characterised as environmental key factors affecting the larval behaviour during early 

development. High larval density decreased the tendency of rovers to leave a food patch 

and reduced their travelled path lengths, so that rovers and sitters showed no more 

significant differences regarding their behaviour. Similar results were obtained when 

starving the larvae. Furthermore, nutrient and yeast deficiency were found to affect the 

larval foraging behaviour and locomotion. 
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Zusammenfassung 

Eine Variabilität der Umwelt während der Entwicklung eines Organismus hat bekannte 

Auswirkungen auf die Expression von bestimmten Verhaltensmustern. Die Fruchtfliege 

Drosophila melanogaster wurde benutzt, um zu untersuchen, wie unterschiedliche 

Umweltbedingungen mit den Allelvarianten von Rovern (forR) und Sittern (fors) am 

foraging Genlocus interagieren, um so das Verhalten von Larven in Bezug auf Futter zu 

beeinflussen. In dieser Studie konnten die larvale Dichte und die Nährstoffverfügbarkeit 

als bedeutende Umweltfaktoren charakterisiert werden, die das Larvenverhalten während 

der frühen Entwicklung beeinflussen. Eine hohe larvale Dichte verringerte die Tendenz 

der Rover eine Nahrungsstelle zu verlassen und verringerte die zurückgelegten 

Weglängen, so dass Rover und Sitter nicht mehr signifikante Unterschiede bezüglich 

ihres Verhaltens zeigten. Ähnliche Ergebnisse konnten erzielt werden, nachdem die 

Larven hungern mussten. Darüber hinaus wurde festgestellt, dass Nährstoff – und 

Hefemangel das larvale Futtersuchverhalten und die Fortbewegung beeinflussen. 
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1 Introduction 

For a deeper understanding of the relationship between genes and behaviour it is essential 

to be aware of the fact that genetic mechanisms controlling behaviour can be modified by 

environmental experiences of an individuum during the development resulting in 

different behavioural phenotypes (Hoke et al., 2019). The concept of genetic variation as 

a response to a changing environment is known as gene-environment interaction. 

Phenotypic plasticity can be described as the extent of influence to which the phenotype 

can be affected or modified by the environment (Via and Lande, 1985). Many different 

genes are involved in establishing a certain behavioural phenotype (Mackay et al., 2009), 

with some genes acting as master regulators (e.g. transcription factors) within this gene 

pathways (Zayed and Robinson, 2012). An example for one of these master regulators of 

behaviour is the foraging (for) gene as it is known for having an important role as modifier 

of behaviour, for example regarding the foraging behaviour in Drosophila melanogaster. 

Being conserved in many species with different functions (Anreiter and Sokolowski, 

2019) makes the gene interesting for further research. 

The for gene in Drosophila is an example of an allelic variation in a single gene 

contributing to behavioural plasticity. The fly gene encodes a cGMP-dependent protein 

kinase (PKG) (Osborne et al., 1997) and natural variation of two alleles in for affects 

larval foraging behaviour. Larvae having the wild-type rover (forR) allele cover longer 

distances while foraging and do not stay as long on the same food patch compared to 

larvae homozygous for the sitter (fors) alleles (Pereira and Sokolowski, 1993; 

Sokolowski, 1980). Furthermore, rovers are characterized by a higher PKG enzyme 

activity compared to sitters in an environment rich of nutrients which results in a lower 

food intake and fat storage than sitter larvae. However, in nutrient-poor environments 

PKG levels in both variants drop to a common level. In addition, rover and sitter differ in 

terms of glucose absorption with rovers having a higher glucose absorption in comparison 

to sitters (Kaun et al., 2007a). This plasticity regarding larval foraging behaviour 

(travelled distances, food intake) and fat levels is regulated by the gene dosage of for 

(Allen et al., 2017).  

This work uses the rover/sitter polymorphism of the for gene in Drosophila to investigate, 

which environmental changes possibly affect food-related larval behaviour. The aim of 
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this bachelor thesis is to study how these both genotypes (forR and fors) would respond to 

changes in the environment. An environmental variation was achieved by raising the 

larvae under different conditions in terms of larval density or nutrient availability. 
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2 Materials and methods 

2.1 Fly stocks and maintenance 

The rover and sitter strains used for the experiments are homozygous for the forR and fors 

alleles and isogenic for the second and third chromosome (Belle and Sokolowski, 1987; 

Sokolowski, 1980). Flies were maintained in plastic vials with food at 25°C and 60% 

humidity on a 12h/12h light and dark cycle. To start the experiments, about 15 female 

flies were allowed to lay eggs for one day and then transferred into new vials. Next, the 

newly hatched offspring was transferred into new vials and after 3-4 days these flies were 

moved to the experimental and standard vials and allowed to lay eggs for one day. All 

newly hatched flies from the control groups were always transferred into new vials and 

again stored for 3-4 days before they were transferred for further experiments in order to 

have a continuous cycle (Figure 1). 

 

Figure 1: Experimental design: 3-4 days old flies which were collected after they were just hatched were 

allowed to lay eggs for one day and then removed. Standard vials contained a normal density of flies (about 

15 females) and standard fly food. Experimental vials included different experimental treatments (high/low 

density, food manipulations). Mid third instar larvae were tested in the experiments. Newly hatched flies of 

the control groups were transferred into new vials for further experiments. 
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2.2 Fly food and agar plates 

2.2.1 Cooking protocols 

Standard fly food and food modified in nutritional composition 

Using an induction cooker, 1 l of water was brought to a boil in a cooking pot. Then, 17 

g of agar-agar dissolved in 350 ml of water was added and also brought to boil. Diastatic 

malt extract and sugar beet syrup were added to the agar-water solution. Next, cornmeal, 

brewer’s yeast and soy meal dissolved in 350 ml water were added to the pot. The mash 

was boiled for about 10 minutes while stirring continuously. Finally, some water was 

added and after a short cooling down, 6 g Nipagin was put into the mixture. The fly food 

was then filled into vials and stored in the cooling chamber. A small amount of living 

yeast paste and a filter paper were added to every vial except to the food without yeast. 

About 20 vials could be obtained following each fly food recipe (Table 1). 

Table 1: Ingredient list for standard fly food and nutrient manipulation food  

 

Starch food 

In a cooking pot, 560 ml water was brought to boil. Then, 15 g agar-agar dissolved in 200 

ml cold water was added to the boiling water while stirring continuously. After that, yeast 

and cornflour (Mondamin) dissolved in 200 ml cold water were put into the agar-water 

solution and boiled for about 10 minutes. After a cooling down (food temperature of 

75°C), Nipagin dissolved in 40 ml water was added. Fly food was filled into vials and 

stored in the cooling chamber. A small amount of living yeast paste and a filter paper 

were added to every vial. About 10 vials with starch food could be obtained following 

this recipe (Table 2).  

 
Corn-

meal 

Brewer's 

yeast 

Soy 

meal 

Diastatic barley 

malt extract 

Sugar beet 

syrup 

Standard 160 g 36 g 20 g 160 g 44 g 

Yeast (0) 160 g - 20 g 160 g 44 g 

Sugar (0,25) 160 g 52,3 g 20 g 97,5 g - 

Carbohydrates (0,5) 50 g 68,8 g 20 g 110,3 g 52,4 g 

Fat (0,5) 160 g 45 g - 103 g 52,5 g 
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Table 2: Starch food ingredient list 

 Cornflour Brewer's yeast Agar - Agar Nipagin 

Starch food 30 g 50 g 15 g 5 g 

 

2.2.2 Nutrient distribution 

The carbohydrate food manipulation contained about half the amount of non-sugar 

carbohydrates as in the standard food. Yeast manipulation food contained no yeast. In the 

fat manipulation food the amount of fats was reduced by about half. Sugar food 

manipulation contained about a quarter of the amount of sugar in the standard food. Starch 

food contained nearly no sugar and a low amount of nutrients in general. For the 

nutritional information of the various products used to calculate the nutrient distribution 

(Figure 2) see Attachment A. 

 

Figure 2: Nutrient distribution in 100 g of each fly food: Number in brackets after the nutritional 

information of the fly food indicates the ratio in comparison to the standard food.  

 

2.2.3 Agar plates 

Table 3: Ingredient list for about 20 standard or black dyed agar plates  

 Agar-Agar Water Activated charcoal powder 

standard 24,5 g 700 ml - 

black 24,5 g 700 ml 1,4 g 

 

0 2 4 6 8 10 12 14 16

Standard

Carbs (0,5)

Yeast (0)

Fat (0,5)

Sugar (0,25)

Starch

Nutrient content in g

F
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Fats Carbohydrates (not sugars) Sugar Protein
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2.3 Starvation protocol 

The method for the starvation of the larvae was taken from Slankster et al. (Slankster et 

al., 2020). A maximum of 30 mid third instar larvae that have previously been removed 

from the standard food and washed, were placed in a petri dish (Ø 6 cm) containing either 

a piece of Kim wipe with 350 µl dH20 (starved) or a piece of Kim wipe with 350 µl of 

0,2 M sucrose (sucrose). The larvae were allowed to move freely within the petri dishes 

for 2 hours at room temperature before they were tested. 

2.4 Control of larval density 

In order to have a standard density of larvae in the food, about 15 female flies, together 

with a few males in one vial, were allowed to lay eggs for one day. To have a low larval 

density about 5 female and a few male flies were together in a vial for one day. A high 

larval density was achieved by keeping more than 30 females together with the males in 

one vial for a day. The adult flies were then removed from the vials the next day and the 

number of laid eggs was checked. 

2.5 Larval experiments 

2.5.1 Food patch 

A small amount of living yeast paste was added to standard agar plates (92 x 16 mm), 

creating two food patches (A and B) on the agar, each about 1,5 cm in diameter (Figure 

3). The distance between the yeast patches was about 3 cm. About 10 mid third instar 

larvae, which had been previously removed from the food and carefully washed using 

small containers with a closed-meshed grid on the bottom, were placed on food patch A 

at the beginning of each experiment. After 20 minutes, the number of larvae that were 

still in food patch A, the number of larvae in food patch B and the number of larvae not 

in any food patch (elsewhere) were counted to calculate the percentage of larvae that were 

still in food patch A and the percentage of larvae having left the first food patch (= larvae 

in food patch B or elsewhere). All experiments were carried out in the 25°C room with 

60% humidity. 
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Figure 3: Food patch experiment: Prepared agar plate. 

 

2.5.2 Distance tracking 

Experimental setup 

To record the larval locomotion, the setup of the Burridan apparatus was used to maintain 

an environment with constant temperature and light using four circular fluorescent tubes 

to illuminate the arena homogenously (Colomb et al., 2012). Black dyed agar plates where 

used to increase the contrast to the white larvae. The agar plates were placed in an elevated 

position within the arena. Larvae, which had previously been removed from the food and 

washed with water, were carefully placed in the centre of the agar plate. The camera, 

connected to a computer running the recording software, was positioned above the arena 

in order to film each larva during the experiment (Figure 4). A one-minute video was 

recorded immediately after the larva was placed on the agar using OBS Studio as video 

recording software. Larvae that crawled under the agar before one minute were discarded. 

 

Figure 4: Burridan’s paradigm (Colomb et al., 2012): Setup was used to record videos of the crawling 

larvae. Computer used OBS Studio software (not BuriTrack) to record the videos. 
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Kinovea tracking software 

The program Kinovea was used to track the movement of each larva. Kinovea is a video 

player for sport analysis, but provides different features like the ability of tracking objects 

(Kinovea 0.8.15, 2009). After successfully tracking a larva (Figure 5), the program 

generates a text file containing the x and y coordinates (in cm) at each point in time (in 

ms). For further instructions on how to use the program see Attachment B. 

 

Figure 5: Path tracking using the Kinovea software: Example of a finished trajectory of a larva moving 

on black dyed agar for one minute. 

 

R script 

A script based on R studio was used to evaluate the Kinovea data in order to determine 

the individual travelled distances of the larvae. The following formula shows how the 

travelled distance D (in cm) was calculated, with x = x-coordinates, y = y-coordinates and 

z = total number of coordinate pairs (Hemmerich, 2011-2020): 

𝐷 =∑√(𝑥𝑡 − 𝑥𝑡+1)2 + (𝑦𝑡 − 𝑦𝑡+1)2
𝑧−1

𝑡=1

 

Using the script, the data will be shortened to the desired end time (60 s) before the 

distance is calculated. The script is also able to detect the time at which the larva starts 

moving (in ms) by determining the point in time after which the first distance is not equal 

to zero. The mean distance (in cm) and the mean time of first movement (in ms) can be 

calculated for all text files within one group. For further information on how to use the 

script see Attachment C. 
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2.6 Statistical analysis 

2.6.1 Sample size calculation 

Using R Studio, a two-sample t test power calculation was carried out prior to the 

experiments with data from the food patch and the distance tracking experiment of larvae 

that grew up in standard food with a normal density in order to determine the sample size 

n (Table 4). 

Table 4: Two-sample power analysis 

Experiment n delta sd sig.level power alternative 

Food patch 13,23 0,17 0,17 0,05 0,8 one.sided 

Distance tracking 18,17 1,38 1,64 0,05 0,8 one.sided 

 

2.6.2 Testing for statistical significance 

Food patch experiment 

To look for a significant difference in the comparison of rovers and sitters regarding the 

food patch experiment, a wilcox.exact test was carried out, using R studio due to the fact 

that the data was not normally distributed (Shaipiro-Wilk-Test, p < 0,05). To compare the 

respective variant (rover/sitter) of the control group to the equal variant of the 

experimental groups, a Kruskal-Wallis-test with posthoc Dunn’s test was used in order to 

look for significant effects of the larval environment. 

Distance tracking experiment 

A t-test was used to compare the travelled distances of rovers and sitters within one 

experimental group as the data was normally distributed (Shaipiro-Wilk-Test, p > 0,05). 

To look for significant differences in path lengths between control group and 

experimental groups of each variant (rover/sitter), an Anova with a posthoc Dunnet-test 

was carried out. 



Results 

12 

 

3 Results 

3.1 Food manipulation 

As previous studies had shown, that the expression of phenotypes related to the foraging 

behaviour regarding the for gene is affected by the food quality in the environment 

(Anreiter et al., 2016; Kaun et al., 2007a), I wanted to determine whether deficiency of a 

certain nutrient in the fly food could have an impact on food-related larval behaviour. To 

do this, standard fly food was analysed for the nutritional composition and the main 

nutritional components were reduced as much as possible in the respective fly food 

(Figure 2). Due to the fact, that it was difficult to reduce the amount of protein as a single 

nutritional component, fly food containing no yeast was used as a low-protein 

manipulation. A nutrient-poor starch fly food containing nearly no sugar was used as a 

further treatment. The experimental design (Figure 1) allowed rover and sitter larvae to 

grow up in an environment that differed only in terms of the nutritional composition of 

the food. Mid third instar larvae were tested for their tendency to leave the first food patch 

(food patch A) after 20 minutes (Figure 3, Methods) and their travelled distances on an 

agar plate within one minute (Figure 5, Methods) were measured after growing up under 

six different food conditions: standard food (standard), food containing half the amount 

of non-sugar carbohydrates (carbs 0,5) or half the amount of fats (fat 0,5) compared to 

the standard food, food containing a quarter of the amount of sugar (sugar 0,25) in the 

standard food, as well as food containing no yeast (yeast 0) and starch food (starch) 

(Figure 6). Larvae were delayed in their development by about one day when growing 

up in the carbohydrate, fat and sugar manipulation food. Yeast deficiency in the food 

resulted in a larval development delayed by about 4 days. 

Looking at the behavioural differences between rovers and sitters regarding the foraging 

behaviour (Figure 6 A) revealed, that rovers had a significant higher tendency to leave 

the first food patch compared to sitters when the larvae were raised in standard food 

(wilcox.exact, p = 0,009), carbohydrates (0,5) food (wilcox.exact, p < 0,0001), starch 

food (wilcox.exact, p = 0,03), and food with no yeast (wilcox.exact, p < 0,001). No 

significant differences were found between rovers and sitters when they were exposed to 

the food with a reduced amount of fat (wilcox.exact, p = 0,27) or sugar (wilcox.exact, p 

= 0,31). Next, a non-parametric Kruskal-Wallis-test with a posthoc Dunn’s test for 
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multiple comparison was performed. Both mid third instar sitter and rover larvae had a 

significant higher tendency to stay in the first food patch when they were exposed to the 

starch food compared to sitter and rover larvae growing up in standard food (Kruskal-

Wallis-test with posthoc Dunn’s test, sitters, p = 0,002; Kruskal-Wallis-test with posthoc 

Dunn’s test, rovers, p = 0,002). There was also a significant difference between sitters 

growing up in standard food and sitters growing up in the no-yeast food (Kruskal-Wallis-

test with posthoc Dunn’s test, p = 0,003). 

Analysing the travelled distances of forR and fors larvae (Figure 6 B) revealed significant 

differences between rover and sitter larval path lengths after they grew up in the standard 

food (t-test, p =0,048) the carbs (0,5) food (t-test, p =0,016), the fat (0,5) food (t-test, p 

=0,002), and the yeast (0) food (t-test, p =0,002). There was no significant difference 

between rover and sitter distances when larvae had to grow up in the starch food treatment 

(t-test, p =0,067). Sitter larvae that grew up in food with no yeast covered a significantly 

shorter distance compared to sitters growing up in standard food (Anova with posthoc 

Dunnet-test, p = 0,043). 
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Figure 6: Behaviour analysis of rover and sitter larvae exposed to different nutritional conditions 

throughout their larval life: (A) Mean percentage of larvae still in food patch A after 20 minutes. Brackets 

above each experimental group with stars indicate whether there is a significant difference between rover 

and sitter behaviour (non-parametric wilcox.exact test). Thick lines with significance stars above indicate 

that there is a significant difference between the rovers/sitters of a food manipulation treatment in 

comparison to the rovers/sitters of the standard food treatment (non-parametric Kruskal-Wallis-test with 

posthoc Dunn’s test for multiple comparison). (B) Mean distance of larvae moving for one minute on an 

agar plate. Brackets above each experimental group with stars indicate whether there is a significant 

difference between rover and sitter path lengths (t-test). Thick lines with significance stars above indicate 

that there is a significant difference in path lengths between the rovers/sitters of a food manipulation 

treatment in comparison to the rovers/sitters of the standard food  treatment (Anova with posthoc Dunnet 

test). Error bars represent standard error of the mean (SEM). Number of stars represent p-value (*p < 0,05, 

**p < 0,01, ***p < 0,001, ****p < 0,0001, ns p > 0,05). Number within the bar charts represents the number 

of experiments (n). 

3.2 Larval starvation 

To understand how larvae would react to starvation, mid third instar rover and sitter larvae 

were exposed to an environment either without any nutrients (dH20, starved) or with only 

sucrose as the nutrient (sucrose) for 2 hours (Methods). After that, their tendency to stay 

in the food patch as well as their path lengths were analysed (Figure 7). As a control 

group, larvae that were taken directly out of the food were also tested.  

Analysing the foraging behaviour of rover and sitter larvae (Figure 7 A) revealed, that 

rovers had a significant higher tendency to stay in the first food patch compared to the 

controls taken directly out of the food when they had been starved (Kruskal-Wallis-test 

with posthoc Dunn’s test, p < 0,001) or when they had sucrose as only nutrient (Kruskal-

Wallis-test with posthoc Dunn’s test, p < 0,001) for 2 hours. As a result, the significant 
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difference between rover and sitter behaviour as it was observed in the control group 

(wilcox.exact, p < 0,0001) could no longer be seen in the starved experimental group 

(wilcox.exact, p = 0,35), as well as in the experimental group with only sucrose as nutrient 

(wilcox.exact, p = 0,12). Sitter larvae that were restricted in their nutrient availability 

(starved group and sucrose group) did not differ significantly from sitter larvae of the 

control group. 

Similar results were found when looking at the differences in path lengths (Figure 7 B). 

Rover larvae that had been under starved conditions showed significant shorter path 

lengths when compared to the control rover larvae (Anova with posthoc Dunnet-test, p < 

0,001). Also rovers that were exposed to sucrose as only nutrient covered a significant 

shorter distance compared to the controls (Anova with posthoc Dunnet-test, p = 0,009). 

Furthermore, sitters showed significant lower path lengths compared to the control sitters 

when they had been starved for 2 hours (Anova with posthoc Dunnet-test, p = 0,04). The 

significant difference between covered distances of rovers and sitters that could be seen 

in the control group (t-test, p = 0,017) could no longer be observed when the larvae had 

been starved (t-test, p = 0,67) or had sucrose as only nutrient (t-test, p = 0,26). The 

differences between rovers and sitters regarding their travelled distances could already be 

seen at an earlier point in time in the control group (Figure 7 C). 
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Figure 7: Behaviour analysis of rover and sitter larvae under starvation conditions: (A) Mean 

percentage of larvae still in food patch A after 20 minutes. Brackets above each experimental group with 

stars indicate whether there is a significant difference between rover and sitter behaviour (non-parametric 

wilcox.exact test). Thick lines with significance stars above indicate that there is a significant difference 

between nutrient-limited rovers/sitters (sucrose/starved) in comparison to non-starved control rovers/sitters 

(non-parametric Kruskal-Wallis-test with posthoc Dunn’s test for multiple comparison). (B) Mean distance 

of larvae moving for one minute on an agar plate. Brackets above each experimental group with stars 

indicate whether there is a significant difference between rover and sitter path lengths (t-test). Thick lines 

with significance stars above indicate that there is a significant difference in path lengths between nutrient-

limited rovers/sitters (sucrose/starved) in comparison to the non-starved control rovers/sitters (Anova with 

posthoc Dunnet). (C) Mean distance (in cm) as a function of time (in s). Lines with significance stars show 

if there is a significant difference between rover and sitter path lengths after 60 s (t-test). Error bars represent 

standard error of the mean (SEM). Number of stars represent p-value (*p < 0,05, **p < 0,01, ***p < 0,001, 

****p < 0,0001, ns p > 0,05). Number within the bar charts represents the number of experiments (n).  
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3.3 Larval density manipulation 

Previous studies had shown an impact of larval density on the phenotypic expression in 

Drosophila, for example regarding the body size (Santos et al., 1994). To determine 

whether larval density could affect the foraging behaviour or the locomotion of rovers 

and sitters, mid third instar larvae where tested after growing up under high-density, low-

density and standard-density conditions (Methods) (Figure 7). Larvae that grew up under 

a high larval density reached mid third instar stage about one day later than larvae that 

grew up under a low or standard density. 

Rover and sitter larvae showed a significant difference regarding their tendency of staying 

in the first food patch in the control group with a standard density (wilcox.exact, p = 

0,0014) as well as in the experimental group with a low density (wilcox.exact, p = 0,0012) 

(Figure 8 A). In contrast, rovers and sitters that grew up under a high larval density had 

a significant higher tendency to stay in their first food patch compared to control larvae 

(Kruskal-Wallis-test with posthoc Dunn’s test, rovers, p = 0,001; Kruskal-Wallis-test 

with posthoc Dunn’s test, sitters, p = 0,041). As a result, no more difference between 

rover and sitter foraging behaviour could be observed in the high density treatment 

(wilcox.exact, p = 0,596). 

The evaluation of the larval path lengths revealed similar results as in the food patch 

experiment (Figure 8 B). Rover and sitter larvae showed a significant difference 

regarding their path lengths when grown up under a normal standard density (t-test, p = 

0,003) or under a low larval density (t-test, p < 0,0001). Low-density rovers covered a 

longer distance on the agar within 1 minute compared to the standard density rovers, but 

the difference was not significant (Anova with posthoc Dunnet test, p = 0,17). However, 

rover larvae grown up under a high density showed significant lower path lengths when 

compared to the rovers grown up under standard density (Anova with posthoc Dunnet 

test, p = 0,04) resulting in no more significant difference in path lengths between high-

density forR and fors larvae (t-test, p = 0,45). 
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Figure 8: Behaviour analysis of rover and sitter larvae grown up under different larval densities: (A) 

Mean percentage of larvae still in food patch A after 20 minutes. Brackets above each experimental group 

with stars indicate whether there is a significant difference between rover and sitter behaviour (non-

parametric wilcox.exact test). Thick lines with significance stars above indicate that there is a significant 

difference between the rovers/sitters grown up under a high/low larval density in comparison to the 

rovers/sitters grown up under standard density (non-parametric Kruskal-Wallis-test with posthoc Dunn’s 

test for multiple comparison). (B) Mean distance of larvae moving for one minute on an agar plate. Brackets 

above each experimental group with stars indicate whether there is a significant difference between rover 

and sitter path lengths (t-test). Thick lines with significance stars above indicate that there is a significant 

difference in path lengths between the rovers/sitters grown up under a high/low larval density in comparison 

to the rovers/sitters grown up under standard density (Anova with posthoc Dunnet test was performed). 

Error bars represent standard error of the mean (SEM). Number of stars represent p-value (*p < 0,05, **p 

< 0,01, ***p < 0,001, ****p < 0,0001, ns p > 0,05). Number within the bar charts represents the number of 

experiments (n). 

3.4 Times of first movement 

In general, only slight differences regarding the times of the first movement of rover and 

sitter larvae were observed within all experimental treatments with larvae starting to move 

after about 1,5 s on average (Figure 9). Not surprisingly, the time of the first movement 

depended on how much the larvae were restricted in their nutrient availability, with  a 

high restriction (starvation) leading to a later first movement (Figure 9 B).  
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Figure 9: Mean times of first movement (in ms): (A) Food manipulation experiment (B) Starvation 

experiment (C) Density manipulation experiment. Error bars represent standard error of the mean (SEM). 

Number within the bar charts represents the number of experiments (n). 
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4 Discussion 

With both experiments carried out (food patch, distance tracking) it was possible to 

determine behavioural differences between rovers and sitters who grew up under standard 

conditions (Figures 6, 7 and 8). Control rovers showed a significant higher tendency of 

leaving the food patch as well as significant longer path lengths on the agar plate, when 

compared to the control sitters. Interestingly, Kaun, et al. found significant differences in 

foraging trails between rover and sitter during a 15 minute test on an agar plate with a 

small layer of yeast, but no significant differences in path lengths between rover and sitter 

during a test on non-nutritive agar (Kaun et al., 2007a). However, due to the fact that in 

the experiment used for this study, larvae were taken directly out of the food and the 

covered distance on the agar was determined immediately after a much shorter time of 

only 60 seconds, larvae might still have been looking for food on the agar and thus show 

a foraging behaviour, resulting in significant different path lengths between rover and 

sitter larvae. 

As the results of this study suggest, larval density seems to be a key factor affecting larval 

behaviour connected to food (Figure 8). A high larval density during the development 

produced a gene environment interaction that led to significant lower path lengths of rover 

larvae when compared to rovers growing up under a normal density. In contrast, sitter 

path lengths did not differ significantly compared to the control group after growing up 

under a high larval density. As a result, rover-sitter differences regarding the distances 

travelled on the non-nutritive agar could no longer be observed. In addition, both rover 

and sitter larvae raised under a high larval density showed a significant higher tendency 

of leaving the food patch when compared to the control group, which led to the result, 

that no more significant rover-sitter differences regarding this behaviour could be 

observed. Furthermore, larvae grown up under a low larval density showed a similar 

behaviour regarding their tendency of leaving their food patch and their path lengths 

compared to larvae grown up under a standard larval density. One possible explanation 

for the reduced tendency of rover and sitter larvae to leave the food patch after growing 

up under a high larval density could be the cooperative feeding behaviour. Social 

aggregation can be seen in different species including Drosophila larvae. A participation 

in a cooperative feeding group can lead to different fitness benefits, for example animals 

can process food more easily in order to get nutrients (Valone, 1989) or reduce the risk 
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of predation (Turchin and Kareiva, 1989). Dombrovski et al showed, that Drosophila 

larvae, foraging in liquid food under crowded conditions, form feeding clusters, in order 

to dig deeper or drag a common air cavity (Dombrovski et al., 2017). As a result of 

growing up under a high density, larvae could consequently still show a cooperative 

feeding behaviour by forming feeding clusters on the yeast patch and therefore remain 

together on the food they are placed on first. Another study showed a delay in 

development for Drosophila larvae raised under crowded conditions, possibly due to a 

decrease in nutrients of the medium (Dombrovski et al., 2020). The high-density larvae 

used in these experiments were also delayed in their development and thus tested one day 

later compared to the larvae raised under a normal or low larval density. Therefore, the 

decreased nutritional value of the substrate could be a further explanation for the observed 

behaviour, as a previous study had already demonstrated an effect of lower food quality 

on foraging behaviour (Anreiter et al., 2016; Kaun et al., 2007a). Also, intra-group 

competition could play a role, as the larvae have to compete for the reduced amount of 

nutrients within the food. Furthermore, larvae growing up under a normal or low density 

are able to roam freely within the food whereas larvae developing under crowded 

conditions may be restricted in terms of their ability to move freely within the food, which 

could also be an explanation for their reduced tendencies to explore their environment 

resulting in the observed significantly shorter path lengths of rover larvae that grew up 

under a high larval density.  

To be able to further interpret the results of the food manipulation experiment (Figure 6), 

it is important to be aware of the previously described impact of the larval density on the 

larval behaviour. Due to the fact that larval density within these experiments was only 

controlled via the number of females (about 15), that were allowed to lay eggs for one 

day, there may have been differences in the density of larvae for the different nutritional 

treatments, since food quality can also influence the egg laying rate (Watada et al., 2020). 

However, the results of this study are still sufficient, to show the effect of food quality on 

the larval behaviour. As expected, growing up in food, in which only the amount of non-

sugar carbohydrates was reduced, but the sugar, protein, fat and yeast amount was similar 

to the standard food, did not lead to a significant change of the larval behaviour, so that 

significant rover-sitter differences regarding path lengths and food-leaving tendencies 

could still be observed. Furthermore, even if there was still a significant difference 

between rovers and sitters regarding the tendency to stay in the food patch, both rover 
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and sitter larvae stayed significantly more often in the food patch they were placed on 

first, when they were exposed to nutrient-poor starch food with a highly reduced amount 

of sugar, protein and fat. When developed in food with a reduced amount of fat (fat 0,5) 

or sugar (sugar 0,25), significant rover-sitter differences regarding the larval tendency of 

leaving the food patch could no longer be observed. However, neither sitters nor rovers 

that grew up in the low-fat or low-sugar food showed a significant difference in their 

food-leaving behaviour compared to the controls (standard food), which means, that it 

cannot be clearly determined, whether one of these nutrients really has an influence on 

this larval behaviour. Analysing the path lengths revealed, that the treatment with starch 

food was sufficient to achieve no more significant differences in path lengths between 

rover and sitter. These results confirm previous studies in which it was shown, that larval 

path length depends on food quality (Anreiter et al., 2016; Kaun et al., 2007a) and 

therefore indicate that food quality is an environmental factor modulating the plasticity 

of food-related behaviour in Drosophila larvae. 

In addition, yeast deficiency seems to affect foraging behaviour and path lengths of sitter 

larvae. Interestingly, Klepsatel et al. found, that yeast deficiency could be the reason for 

previous observed life-history traits in Drosophila due to larval crowding, as a yeast-rich 

larval diet was able to rescue the effects of a high larval density, for example regarding 

body size or developmental time. The fact that sitter larvae, that grew up in food without 

any yeast showed a significant higher tendency to stay in the food patch, as well as 

significant lower path lengths compared to sitter larvae, that were able to develop in the 

standard food containing yeast, indicates, that yeast availability during larval 

development may play an important role in the expression of the observed behavioural 

patterns and  might consequently be another explanation for the previous described effects 

of a high larval density. However, as the limited yeast availability only had a significant 

influence on the larval path lengths of the sitters, whereas a high larval density only 

significantly affected the larval path lengths of rovers, further studies will be needed to 

investigate on a possible relationship between yeast availability and larval density and 

the associated effects on the behaviour of rover and sitter larvae. 

Looking at the previous results, it is no surprise that also starvation affects larval 

behaviour (Figure 7). Starved rovers and rovers restricted in terms of nutrients (only 

sucrose) showed a significantly lower tendency to leave the food patch, as well as 
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significantly shorter path lengths compared to non-starved rovers. Also sitter path lengths 

were significantly shorter after starving the larvae when compared to the control sitters, 

but the availability of only sucrose was sufficient to prevent the previous reduction in 

travelled distances due to starvation. Furthermore, there was no significant effect of 

starvation or nutrient restriction on food leaving tendencies of sitter larvae when 

compared to the non-starved sitters. As the availability of nutrients is essential for any 

organism to provide the energy needed to survive and maintain metabolic activities and 

as starvation can lead to drastic consequences such as a rapid suppression of the protein 

expression or the progression of the cell cycle (Scott et al., 2004), it is not surprising that 

that especially rovers react very sensitive to nutrient limitations in their environment by 

leaving their food patch less often and covering shorter distances on the agar in order to 

rapidly replenish energy reserves or to save energy. This makes it very clear that nutrient 

availability is an important environmental factor and that even short-term restrictions in 

nutrient availability can cause serious changes in the phenotypic expression of food-

related behavioural patterns in larvae. 

In Drosophila the for gene is known to effect a wide range of behavioural traits apart of 

food-related behaviour, for example learning and memory (Kaun et al., 2007b; Mery et 

al., 2007), olfactory behaviour (Arya et al., 2015; Colomb et al.) as well as sleep (Donlea 

et al., 2012), which opens a wide field for further investigations. Given the fact, that the 

for gene is conserved across many different species (Anreiter and Sokolowski, 2019), 

further studies will show whether similar gene-environment interactions can also be 

observed at the for gene orthologs of other species.  
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Attachments 

A) Nutritional information of the respective products 

Table 5: Nutrient distribution in 100 g of the products used for the fly food: Nutritional information were 

taken directly from the products used for cooking the fly food. 

 

Corn

meal 

Brewer's 

yeast 

Soy-

meal 

Diastatic barley 

malt extract 

Sugar 

beet syrup 

Cornflour 

(Mondamin) 

Fats 1,1g 3,7 g 24,5 g 2,5 g - 0,5 g 

Carbohydrates 

(no sugars) 72,3 g 5,9 g 10,2 g 59,4 g 4 g 86 g 

Sugar 1,5 g 0,2 g 5,3 g 8 g 66 g - 

Protein 8,8 g 44,8 g 39,6 g 10,1 g 2,3 g 0,5 g 

 

B) Kinovea tracking guide  

1. Start Kinovea program. 

2. Import video by clicking on File -> Open Video File. 

3. Set time format: Options -> Time markers format -> Total milliseconds. 

4. To express distance in real life units add a line with the diagonal length of the 

black agar, then right click on the line -> Calibrate measure -> Change Real size 

of the segment to 8.5 cm (diameter of the agar plate). 

5. For tracking the object: Right click in the middle of the larva -> Track path. 

6. Start tracking by clicking on play. 

7. If the tracking was misplaced go to the image corresponding to the misplaced 

point, then right click the path -> Restart Path Edition and adjust the point 

location. After editing the tracking, click on End Path Edition. 

8. Safe trajectories by clicking on File -> Export to Spreadsheet -> Trajectories to 

simple text 

More information about the program can be obtained at the Kinovea website 

(https://www.kinovea.org/help/en/109.html). 
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C) R script guide 

Analyse larval movement of a single group (Calculate_Distance.R) 

1. Safe your text files from the Kinovea tracking program in folders referring to the  

Experiment and Fly Group (for example “Starved” -> “ForR”). 

2. Open the Calculate_Distance.R script in R studio. 

3. Make sure the required libraries are installed. 

4. Set working directory by changing setwd to the file path where your folders are 

stored. 

5. Change Experiment to the name of the experiment (= name of the Experiment 

folder, for example “Starved”) and Group to the fly group (= name of Group 

folder in the Experiment folder, for example “ForR”) you want to evaluate. If you 

have no subfolders in the Experiment-folder you need to adjust the code. 

6. Run the script -> A csv-file is generated containing information about the name 

of the Experiment and Group, the distances in cm of each larva and the time of 

the first movement of each larva. To adjust where this file should be stored change 

setwd above the write.csv function to your desired file path.  

7. The plotted trajectories containing information about the name of the text file and 

the calculated distance can now be checked for each file. 

8. You can also check the bar plots of mean distance and mean time of first 

movement. 

Compare larval movement data of different groups (Compare_Distances.R) 

1. Store the csv-files from the previous script in a folder where the same 

experimental groups are in the same folder (for example “Starved” folder contains 

the csv files of “Starved_ForR” and “Starved_ForS”). 

2. Open the Compare_Distances.R script in R studio 

3. Make sure the required libraries are installed. 

4. Set working directory by changing setwd to the file path where your folder 

containing the different experimental groups is stored 

5. Run the script. 

Both R scripts are available at “https://github.com/SimonBnm/Kinovea-Trajectories-

Evaluation”.  
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